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How To Use WordPress Post Tags
wptrainingmanual.com/wordpress-tutorials/wordpress-post-tags

Using Post Tags In WordPress

Tags can help your site visitors find what they are looking for quickly and easily, keep them
engaged longer on your site, and let search engines know what your content is all about.

In this tutorial, we cover the following:

What are tags?
Difference between tags and categories
Benefits of using tags in content
Using tags effectively in your posts

https://wptrainingmanual.com/wordpress-tutorials/wordpress-post-tags/
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Managing tags in WordPress
How to add, edit, and delete tags
Sorting, searching, and grouping tags

Enhancing tag functionality with WordPress plugins

What Are Tags?

A Tag is a keyword that provides a useful reference for visitors and search engines.

Tags are essentially words or short two to three-word keyword phrases that help describe
what your posts and pages are about.

Tags that accurately represent what your posts are about can help increase traffic and user
engagement on your website. They do this by allowing users and search engines to find
relevant and related content on your site.

Tags need to be used and managed correctly, as “over-tagging” posts can dilute their
effectiveness. Adding too many tags is the equivalent of “keyword stuffing,” which search
engines like Google frown upon.

Tags Vs Categories

It’s important not to confuse Tags with categories.

A Tag is like a Category but smaller in scope. Categories are broad, and Tags are granular.

While a post may be filed under a single category, it may be referenced using several tags.

Post Categories hardly change, but posts published under these categories have different
content, therefore, you will probably want to use different Tags to reference the information in
your content.

To understand how tags differ from categories, think about how you would store information
in a filing cabinet.

What’s an effective way to keep all your content organized in a filing cabinet for easy access
and retrieval?

Let’s say you subscribe to 3 different services: ABC, PQR, and XYZ.

An effective way to manage all the information associated with these subscriptions (e.g. bills,
invoices, notices, etc.) and keep things organized in your filing cabinet would be to file the
information in separate manila folders (labeled ABC, PQR, and XYZ) and then store these
manila folders in a filing cabinet drawer called ‘Subscriptions’.

https://wptrainingmanual.com/wordpress-tutorials/wordpress-post-categories/
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In this analogy, each filing cabinet drawer is a category, every manila folder stored within a
drawer is a tag, and each tag is associated with one or more items of content (bills, invoices,
notices, etc.)
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WordPress tags let you organize your content in a more granular way than categories.

Let’s now go one step further…

Different companies may charge subscriptions differently (e.g. weekly, fortnightly, monthly,
quarterly, six-monthly, yearly, etc.)

They may also provide different invoice payment terms (e.g. 7-day, 14-day, 30-day, autopay,
direct debit, etc.)

And they may send out different types of notices to customers (e.g. reports, meetings,
special offers, discounts, newsletters, etc.)

So, if we were to try and organize all the information stored in our filing cabinet effectively for
easy access and fast retrieval, we would find that a ‘label map’ of our stored content may be
structured as shown below:
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Our example information organized by label map. Different labels use different colors and identical labels
share the same color.

If we were to then create a list of all the unique tags we’ve used to label all the information
stored in our filing cabinet, it would look like this:
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We can organize all the content in our filing cabinet using the above tags.

With an electronic filing system powered a content management system (CMS), you can
easily retrieve any stored item simply by searching for or clicking on a tag. This will then
bring back a filtered list of all the content stored with that tag, even if the items were filed
under different categories.

That’s the effectiveness of using tags to organize your content.

WordPress is a content management system that lets you store your information under broad
topics (categories) and keep your content organized and filterable at a granular level using
tags.

Now that you understand the concept, let’s look at some actual examples of how sites and
blogs use tags to organize their content.
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Here’s a screenshot of a post from a cruise travel blog tagged using a single tag (Princess
Cruises):

Example of a post filed using a single tag. (image: TheCruiseBlogger.com)

Clicking on this tag brings up a list of all posts filed using the tag Princess Cruises:
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Here are all the posts on this blog filed under the same tag.

As this blog covers different cruise-related topics, it also offers a ‘tag cloud’ to make it easier
for visitors to find what they are looking for by clicking on a tag.
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An example of a Tag cloud for a cruise-related blog with clickable tags.

Many recipe sites also use tags to organize their content. With a recipe blog, for example,
you could categorize your recipes by meal type (e.g. breakfast recipes, lunch recipes, dinner
recipes, dessert recipes) or by cuisine (e.g. Italian, Chinese, French).



11/59

As you add new recipes to your site, you would then tag these posts using keywords that will
make it easier for your visitors to find all the recipes on your site grouped under similar
topics.

For example, you could create tags based on the main ingredients of the recipe (e.g.
chicken, eggplant, cayenne pepper), food preparation methods (e.g. steamed, roasted),
types of diet (keto, vegan, gluten-free), and/or a combination of all these.

You can use tags to help readers find recipes based on keywords related to ingredients, cuisine types, etc.

In the screenshot below, which is taken from an actual recipe blog powered by WordPress, if
you click on the “chocolate” tag at the end of one of their recipe posts…

Mmmmm…chocolate!

…you will be taken to a page listing all the recipes on their site featuring chocolate as a main
ingredient.
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All these recipes use chocolate. (Source: alldayidreamaboutfood.com).

Benefits Of Using Tags – When To Use Tags

The examples above illustrate how tags can be used to:

Improve User Experience: Tags make it easier and faster for visitors to navigate your
site and find related content.
Improve User Engagement: Tags can help users stay longer on your site as they click
through to other posts to explore other recipes or content they are interested in.
Improve SEO: Tags can also help search engines understand the context of your post
content. Note: In terms of SEO, tags are not as important now for indexing purposes as
they used to be. This is because search engines like Google have significantly
improved their algorithms and can better understand what your content is all about. For
example, Google can easily tell the difference between a post that talks about making
‘Apple phones’ vs making ‘apple pies.’

If your site already has a good navigation structure with menus, category lists, search box,
related posts features, etc., then tagging your posts may not be as important for visitors or
search engines. There is no downside to using tags, however, provided you choose tags that
will benefit your users and add value to their experience.

How To Use Tags Effectively

Use tags sparingly. Keep each tag short (no more than two or three words) and make sure
they are completely relevant to the content of your post. Avoid keyword stuffing.

Many experts recommend adding no more than around 5-10 tags to each post.
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Think about the focus and purpose of your content. What is your site about? Which topics
feature most prominently in your content? What keywords best define the essence of your
post? Use this as the basis for planning your post tags.

In the screenshot below, for example, you can see that the post writer has identified five
keywords that she feels best represent her dish. She then used these keywords as recipe
post tags (in this example, the label ‘tags’ has been renamed as ingredients).

These ingredients define the author’s dish. And you can find other recipes that use these ingredients by
clicking on the tags. (Source: cookieandkate.com)

Some SEO experts advise not to include keywords if they are not relevant enough to warrant
tagging, even if they appear in your content. The thinking behind this is that tags should not
only relate directly to the content of your post, but they should also help define the focus of
your site.

So, if you really want search engines to know that your site is all about travel, for example,
try to keep all tags specifically related to travel terms. Even if you publish local recipes from
the places you are traveling to or writing about, make sure the words remain focused on
travel, not food, as this will then start to confuse and dilute the focus of your site (i.e. is your
site about travel or food?)
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Also, if a tag is only used a few times throughout your site, there is probably little point in
using it, as this indicates that that specific term is not relevant to your website’s content
strategy.

Likewise, if almost all your posts were to use the same tag, then that tag is probably too
general to provide any real value to users searching for specific information. For example, if
you run a blog dedicated exclusively to chicken recipes, using the keyword ‘chicken’ as a tag
would be unnecessary, as anyone clicking on it will get a list comprised of almost all the
posts on your site.

When thinking about keywords to tag your post with, put yourself in your visitors’ shoes.

Ask yourself if the keyword:

Best represents the content you are reading, and
Would it make you want to click on it to discover other related posts on that topic?

If the answer to both is “yes” then it’s probably a useful tag. If not, don’t bother using it.

How To Add Tags To Posts In WordPress

Now that you understand what tags are and what they do, let’s show you how to use them in
your posts.

The screenshots in the tutorial below were created using the WordPress Classic Editor.

To learn about using tags in the WordPress Block Editor, see this tutorial: The WordPress
Block Editor Interface.

To add tags to your posts, create a new post or edit an existing post, then locate the Tags
box in the sidebar section of your Create/Edit Post screen.

https://wptrainingmanual.com/wordpress-tutorials/wordpress-classic-editor/
https://wptrainingmanual.com/wordpress-tutorials/block-editor-content-area/
https://wptrainingmanual.com/wordpress-tutorials/create-wordpress-post-1/
https://wptrainingmanual.com/wordpress-tutorials/edit-delete-wordpress-posts-1/
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Tags section.

If you can’t see the Tags feature displayed on your screen, click on the ‘Screen Options’ tab
in the top right-hand corner of your screen.

Click the Screen Options tab to view and enable hidden features on your screen.

Make sure that the “Tags” checkbox is ticked in the Show on screen section.



16/59

Make sure the Tags checkbox is ticked to display the Tags feature in your post screen.

Enter your tag(s) into the Tags box and click the Add button.

Enter a tag and click ‘Add’.

You can add multiple tags in the tag text field by typing or pasting in your tags separated by
commas.
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Add multiple tags separated with commas.

As you begin typing in your tag, an auto-complete list appears, allowing you to select existing
tags to add to your post.
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WordPress tags have an autocomplete feature that lets you view all the
existing tags stored in your database.

You can also add tags to your post by clicking on the Choose from the most used tags link
and selecting items from the tag cloud that will display below the link.
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Tags feature box – Choose from the most used tags.

To delete any unwanted tags, click on the little delete icon (x) next to the tag.
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Click ‘x’ to remove a tag from your post.

You can also manage and edit tags quickly and easily using the Quick Edit feature in your
Posts screen (we’ll cover how to do this shortly).

Edit tags quickly in WordPress using the WordPress Quick Editor.

Tag Clouds

https://wptrainingmanual.com/wordpress-tutorials/quick-edit/
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You can display a list of all the active tags used in your content to your visitors on the sidebar
or footer of your site using a Tag Cloud. (Learn how to  add a Tag Cloud widget to your
sidebar.)

Example of a tag cloud for a travel blog.

Tag clouds let your visitors quickly see what your site’s main topics are about.

https://wptrainingmanual.com/wordpress-tutorials/use-widgets-1/
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Example of tag cloud on a travel blog displaying the
site’s most written about topics.

Clicking on a tag in the Tag Cloud…
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Some tag clouds can display the number of posts
using that tag when you hover your mouse over the

link.

…brings up a list of all posts sharing the same tag in a Tag Archives page.
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WordPress displays all posts that share the same tag in a Tag Archives page.

Tags can also be used on eCommerce sites and product reviews.
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Tags can be really useful and profitable when used on an eCommerce site. (Source: Rushfaster.com.au)

This helps customers narrow down their product searches.
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Looking for a new travel wallet? Here’s all the information you need to know…now, open your old wallet
and let’s buy a new one!

Depending on the theme installed on your site or the layout of your web pages, you may or
may not be able to display tag clouds.

Some themes allow you to configure tag clouds to display tags in different sizes or different
colors.

For example, with some tag clouds, the more content you publish using the same tags, the
more prominently those tags will display in the tag cloud and display a proportional
representation of the site’s main topics.

Here is an example of such a tag cloud added to the sidebar via a widget…
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Tag cloud added to a WordPress site via a sidebar widget.

And here’s the same tag cloud displayed on the footer of the WordPress Twenty-twenty
theme…
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Tag cloud added to a WordPress site via a footer widget.

Most modern themes usually match the style of their tag clouds to the site’s overall design.

Some tag clouds are fancy and eye-catching…
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Nice looking tag cloud…

And some tag clouds are plain functional…
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Nothing fancy…just plain and functional.

You can also customize and enhance tag clouds using plugins. This is covered later in the
tutorial.

Managing WordPress Post Tags
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Now that you know how to add and use tags in your posts, let’s look at managing your tags
in WordPress.

This section covers how to plan, add, edit, and delete tags.

Planning Your Tags

Before creating a new post, it’s good to spend some time planning your content, the
keywords you will target in your content, and the topics you will address in your posts. It’s all
part of your content marketing strategy.

Unless you’re starting out with a well-thought-out content plan, it’s easier to plan your site’s
categories than to plan your tags.

We definitely recommend planning your categories first when you design and create your
site and before you start publishing content, It may be more practical, however, to add tags
“on the fly” as you write each new post. You can manage your tags later, as we’ll show you
later.

Still, it’s a good idea to do a little planning beforehand. Adding too many tags can dilute the
focus of your content and your website. Keyword research can uncover the right tags to use
and give you great ideas for new content.

Having said that, let’s go through the process of setting up tags in WordPress.

How To Add, Edit, And Delete Tags In WordPress

Log into your WordPress admin area, then click on Posts > Tags.

Select Posts > Tags.

This brings up the Tags screen.

https://wptrainingmanual.com/wordpress-tutorials/content-marketing/
https://wptrainingmanual.com/wordpress-tutorials/website-planning-2/
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All your tags are listed in the WordPress Tags screen.

You can perform various tag management tasks in the WordPress Tags screen, including:

Adding New Tags
Editing Tags (including Quick Edit)
Deleting Single and Multiple Tags (Bulk Delete)
Sorting Tags.
Searching Tags

Let’s go through each of these options:

Adding WordPress Tags
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Tags > Add New Tag

To add a new tag, go to the Tags screen and fill in the following fields in the Add New Tag
section:

Name – Enter a short tag name for your tag, preferably 1-3 words.
Slug – WordPress creates an archive page to display a list of all posts published using
this tag. The slug you enter here will be used to create the URL of your tag archive
page. The slug can be different than the tag name. Note: Keep all words lower case
and make sure they only contain letters, numbers, and hyphens (i.e. no spaces
between words). If you don’t enter a slug into this field, WordPress will create one for
you using a lower-case version of your Tag Name.

Description – Write a brief description of your tag here (optional). Some WordPress
themes display the tag description on your site. This can help with search engine
optimization.



34/59

Add your tag details and click the ‘Add New Tag’ button to add a new tag.

Click the Add New Tag button when done to add your new tag to the Table of Tags.

A newly added tag.

Repeat the above to continue adding new tags.
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Add as many tags as you like to WordPress.

Note that all the tags shown in the screenshot above are not associated with any posts yet.
You can tell this by looking at the ‘Count’ column, which shows you how many posts on your
site use the tag.

In addition to adding tags in the ‘Tags’ screen, you can add new tags “on the fly” while
creating or editing posts.



36/59

You can add tags to posts ‘on the fly’ while creating or editing your posts.

WordPress also lets you add tags to posts by selecting a tag from a list of existing tags as
soon as you begin typing a new tag name into the tag field.

WordPress displays a dropdown list of existing tags as you type a new tag
into the Tags feature section.

Additionally, when you add new tags to a post…
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Add a new tag while creating or editing a post…

…the new tag is automatically added to your Table of Tags.

…and WordPress automatically adds it to your list of Tags.

To learn more about adding tags to WordPress posts, see this tutorial: How To Create Posts
In WordPress

Deleting WordPress Tags

You can delete individual WordPress tags or perform a bulk tag deletion.

https://wptrainingmanual.com/wordpress-tutorials/create-wordpress-post-1/
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How To Delete Individual Tags

Hover over the tag you plan to delete. A menu will display. Click the Delete button in this
menu to remove the tag from your list.

Tags screen – Delete tag menu.

You will see a message asking you to confirm the item deletion. Click OK to proceed or
Cancel to stop.

WordPress asks you to confirm if you really want to go ahead and delete the tag.

Note that deleting a tag in your Tags screen will also remove the tag from all posts tagged
with that item and remove the tag from your WordPress database.
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Unlike categories, posts don’t need to be associated with tags (i.e. you can publish posts
without tags, but not publish posts without a category – hence the reason why WordPress
has a default ‘uncategorized’ category).

How To Delete Tags In Bulk

If you have too many tags to delete individually, you can use the bulk delete feature.

To bulk delete tags:

Click on the main checkbox in the header row (next to the “Name” column title). This will
select all the tags on the page.

Select all tags at once or individually by ticking/unticking checkboxes.

Go through your list of tags and deselect any tags that you DO NOT want to delete. You can
select/deselect tags individually by toggling on the checkbox next to the item.

After selecting all the tags you want to delete, choose Delete from the Bulk Actions drop-
down menu.
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Select ‘Delete’ from the Bulk Actions dropdown menu.

With ‘Delete’ selected in the drop-down menu, click the Apply button.

With ‘Delete’ selected, click on Apply.

Your selected tags will be deleted.
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Selected tags are now deleted.

Editing WordPress Tags

Depending on how you use tags, if you post content regularly to your site, after a while you
may end up with a bloated list of tags.

To edit or manage your tags, go to your main dashboard menu, and select Posts > Tags.

Select Posts > Tags.

This brings up the Tags screen containing a list of all your tags. Here you can perform
various tag management tasks like adding, editing, and deleting single and multiple tags.
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WordPress Tags screen.

If you are regularly adding content to your site, your tags could end up becoming unwieldy
after a while, especially if you have multiple authors publishing posts on your site (e.g. guest
blogging), or if you use any type of content automation (e.g. auto-blogging), import content
from other sites, etc.

To edit a tag:

Go to your Tags section,
Locate the tag you want to edit,
Hover your mouse over the item, and
Click on the Edit link…

Click on the Edit menu to edit a tag.

This brings up the ‘Edit Tag’ screen. Make the required changes in your tag fields and click
the Update button to save the new details.
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Edit your Tag information and click Update to save your settings.

Click on the ‘Back to Tags’ link after your edit has been saved and your tag has been
updated to return to the main Tags screen or select another option from the main menu.

Click ‘Back to Tags’ to leave the ‘Edit Tag’ screen.

You can also edit a tag using the Quick Edit option. This is useful for quickly correcting
spelling errors in tags or tag slugs.

To use this feature, position your mouse over the tag to edit and click on the Quick Edit link.
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Ooops…there’s a spelling mistake in the tag slug. Let’s use Quick Edit to quickly fix this!

The Quick Edit feature only lets you change the Tag name and slug. Edit these fields if
required and click the Update Tag button to save your changes or click Cancel to leave your
tag details unchanged.

Make your changes and click the Update Tag button when done.

Sorting WordPress Tags

Your Tags table allows you to sort items alphabetically (or in reverse alphabetical order).
Hover your mouse near the column title and click on the little triangle icon that appears next
to the title.
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Click the little black triangle next to Name to sort tags alphabetically in ascending or descending order.

Your tags will be rearranged according to the column selected (e.g. Description, Slug, or
Posts).
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Sort your tags by clicking on the icons next to a column title.

Searching WordPress Tags

Some types of sites that import large amounts of data can end up with loads of tags (e.g.
eCommerce sites with large product catalogs).

You can search for tags quickly by typing in a keyword into the search field and clicking on
the Search Tags button.
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Have you added loads of tags on your site? Use the Search Tags feature!

This will bring up all the Tags that include your search keyword(s) in the Tag name,
description, or slug.
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WordPress returns a list of all tags containing your search keyword.

You can narrow and filter your results further by combining functions like search and sort.
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Use search and sort to locate individual tags quickly.

If you have many tags, WordPress displays the Tag Pages feature in the Tags screen.

The Tag Pages feature displays the number of tags and tag pages on your Tag screen.
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You can specify how many tags to display per page. To do this, click on the ‘Screen Options’
tab at the top of your screen.

Click on the Screen Options tab to view hidden or disabled features on your screen.

Enter the number of tags in the ‘Tags’ field (you can also hide columns like Description, Slug,
and Posts) and click the Apply button.

Enter the number of tags to display per page and click Apply.

Your tag pages will now display the number of tags you have specified.

To learn more about the Screen Options Tab, see this tutorial: How To Use The WordPress
Screen Options Tab

Grouping WordPress Tags

The ‘Posts’ column displays the number of posts assigned to each category. To see which
posts share your tags, click on an item in the Posts column.

https://wptrainingmanual.com/wordpress-tutorials/screen-options/
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The Count column lets you see the number of posts using that tag.

A list of all the posts that share the tag will display in your Table of Posts.

The Posts table displays all the posts filtered by tags.

WordPress Tags – Tools

You can convert Tags into WordPress Categories using the tag to category converter link
found below your Table of Tags.
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Click the ‘Tag to category converter’ link to convert your tags to categories.

This takes you to the Tools > Import section.

Convert tags to categories here.

To learn more about converting tags into categories using the ‘Categories and Tags
Converter’ tool, see this tutorial: How To Use The WordPress Tools Menu

WordPress Tags – Tips & Additional Information

https://wptrainingmanual.com/wordpress-tutorials/tools-menu/
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Unlike categories, tags have no hierarchy, so there is no Parent > Child relationship for
tags like there is for categories.
Like categories, tag names and slugs must also be unique.
You can assign multiple tags to a WordPress post. We recommend using no more than
5 – 10 tags per post.

The Tags feature section displays all the tags you have assigned to a post.

View Tag Archives

To view the Tag Archive page for any tag from your WordPress admin area, go to Post >
Tags. Hover your mouse over the tag and click View.
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Click the View menu link to bring up the Tag archives page for a tag.

This brings up the archive page listing all the posts associated with that tag.

Example Tag archive page.

You can also view the Tag Archive page from the front end of your site by clicking on a tag in
a tag cloud.

Tag SEO
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You can maximize the benefits of using tags to improve your site’s effectiveness in search
engine results using an SEO plugin for WordPress.

SEO plugins let you optimize your tag archive pages by customizing the description that
search engines like Google will display to users.

You can improve your Tag Archives page SEO using a plugin like Yoast SEO.

Now that we have covered all the ways to use tags in a default WordPress installation, let’s
look at additional ways you can extend the usefulness of tags in WordPress.

WordPress Tags – Plugins

Plugins let you enhance or extend the functionality of your WordPress site.

There are many WordPress plugins that can help you manage and organize your tags or
improve their functionality and/or design.

Here are some examples of plugins for tags that you can add to your WordPress site:

https://wptrainingmanual.com/wordpress-tutorials/plugins/
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Cool Tag Cloud

Add a cool tag cloud to your WordPress site.

Cool Tag Cloud adds professionally designed and responsive background tag images to
your tags. These cool tag images work on all user browsers.

Tag Pages

Add tags to your pages too with the Tag Pages plugin.

Normally, only posts display tags. With the Tag Pages plugin installed, you can also add tags
to pages and not just posts.

Tag Groups

https://wordpress.org/plugins/cool-tag-cloud/
https://wordpress.org/plugins/tag-pages/
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Tag Groups – WordPress tag management plugin

Tag Groups lets you organize your tags into categories or groups. This is useful if you want
to manage, sort, and display tag clouds alphabetically, or by specific groups (e.g. town
names, sizes, colors, etc.)

Simple Tags

If the task of managing tags on your WordPress site is becoming too complex, use an advanced tag
management plugin like Simple Tags to save you time and work more efficiently!

Simple Tags gives you advanced tag management functionality like mass tag editing of
posts in bulk, auto-linking tags in post content, and even auto-tagging. You can even let the
plugin analyze your content and automatically suggest tags for your posts.

https://wordpress.org/plugins/tag-groups/
https://wordpress.org/plugins/simple-tags/
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Simple Tags suggests tags for your posts based on their content.

You can search for additional WordPress tag plugins inside your WordPress dashboard
(Plugins > Add New) or browse the Free WordPress Plugin Directory at WordPress.org.

Search the WordPress Plugins Directory

To search WordPress.org for plugins related to tags, click here: WordPress Plugins For
Managing Tags

Congratulations! Now you know how to use tags in WordPress to improve the effectiveness
of your posts.

https://wordpress.org/plugins/
https://wordpress.org/plugins/search.php?q=Tags
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